Additional Notes About 3D Studio VIZ® R2.01





This document (README.DOC) contains information not available in the 3D Studio VIZ R2.x


documentation. Other sources for the latest information about 3D Studio VIZ include:





·	Your authorized Kinetix™ dealer.





·	Kinetix home page on the World Wide Web:	http://www.ktx.com





·	The 3D Studio VIZ Product Support help file:


This help file is regularly updated with the latest information, and answers to questions, 


about 3D Studio VIZ. The file is available for download from the web site listed above.





·	Online Product Support: 				http://www.ktx.com/3dsvizr2


3D Studio VIZ R2.x product support is on the web. After creating a user profile you will enter into a virtual world of web conferencing with Kinetix Product Support, developers, and our customers around the globe. Online Product Support is located on the 3D Studio VIZ web site under Support. 





·	Latest versions of free Kinetix plug-ins:


New and updated free plug-ins are available on the Kinetix web site listed above. 





------------------------------------- GENERAL NOTES -----------------------------------------


System Requirements


Microsoft Windows NT 4.0 with Service Pack 3 or Windows 95® (Windows NT recommended).


Intel compatible processor at 150 MHz minimum (full support of multiple processor systems, dual Pentium Pro, or Pentium II system recommended).


64 MB RAM and 200 MB swap space minimum (amount depends on scene complexity, 128 MB RAM recommended).


Graphics card supporting 800x600x256 colors minimum (1024x768x24-24-bit recommended). OpenGL and Direct3D hardware acceleration supported. 


Direct 3D hardware acceleration requires at least 8mb of on-board memory. 


The most substantial OpenGL performance increase requires 3D Geometry Acceleration support on the hardware. For optimal performance, make sure to obtain and install the latest Windows OpenGL drivers from the respective graphics board manufacturer. 


Windows compliant pointing device (specific optimization for Microsoft Intellimouse).


CD-ROM drive.


Optional: sound card and speakers, cabling for TCP/IP-compliant network, 3D hardware graphics acceleration, video input and output devices, joystick, midi-instruments, 3-button mouse.





Notes About Installation


If you wish to run 3D Studio VIZ under both Windows 95 and Windows NT 4.0, you must install 3DS VIZ separately under both operating systems.  If you do this, you will be required to install into separate directories.





Windows 95/98 Limitations


Multiple sessions of 3DS VIZ are not supported on Windows95 or Windows98.  Unlike Windows NT, Windows95/98 have fixed GDI and UI resource limits.  3DS VIZ is too big for two copies to fit in Windows95/98 at the same time. Therefore 3DS VIZ will not launch a second copy on Windows95/98. 





Possible problems running 3DS VIZ with other applications on Windows95 or Windows98. The fixed resource limits of Windows 95 may prevent applications from displaying elements of their user interface when 3DS VIZ is run concurrently with other applications. When this occurs, one or more applications must be shut down to provide the remaining application(s) access to the fixed number of Windows resources. Preliminary testing has shown that this situation will not improve with Windows 98. 





Network rendering is not supported on Windows 95/98. Although the Network Renderer can be setup and appear functional, network rendering does not work reliably under the Windows95 or Windows98 operating systems.  Icons for Manager, Queue Manager, and Server are not installed automatically during setup.





Microsoft Intellimouse Behavior


Features associated with rolling the MS Intellimouse wheel (e.g., Viewport and Track View zooming) are not supported under Windows95/98. The ability to pan with the Intellimouse wheel as a third button is supported under Windows95/98.





Page Fault in CORE.DLL


Running 3DS VIZ R2.01 on Windows95 and exiting the program returns a "Page Fault in CORE.DLL" error message.  There is no loss of data. Click OK to dismiss the page fault dialog.This does not occur in Windows98.





NT Service Pack 3 Required for IE 4.01


Internet Explorer 4.01 requires NT Service Pack 3 or 4 for operation. Service pack 3 is included on your CD and will be installed as part of the Internet Explorer 4.01/Online Reference installation if it is required for your system. Please note that Service Pack 3 is always recommended to ensure the best possible 3D Studio VIZ operation. 





Windows NT 4.0 versus Windows 95®


3D Studio VIZ R2.x provides different functionality depending upon your choice of operating systems. The following are unique capabilities of each operating system with regard to 3DS VIZ:





Windows NT 4.0


Multiple 3D Studio VIZ Sessions


Simultaneous use of 3D Studio VIZ with other graphic-intensive applications


Network Rendering





Windows 95/98


Direct3D Graphics Display 





Display Support


DirectX 5.0 support is now available on Windows 95/98.  3DS VIZ only supports D3D with hardware acceleration and at high-color display depths  (a minimum of 8MB of on-board memory is required).  The D3D support can come from the hardware drivers that are in the D3D SDK and/or runtime, or it can come from the graphic card manufacturers' own D3D drivers.  Software-only D3D is not supported because it is slower (by at least 2X) than 3DS VIZ's own software SZB (HEIDI) driver. 3DS VIZ uses standard D3D features, however they are not typically used by games. This includes ordinary wireframe displays, dashed lines, screen door transparency, and points.  Many D3D drivers will not have these capabilities debugged and/or running efficiently at first because their primary emphasis is often games and not application performance. 





OpenGL is supported in Windows NT and on the OSR2 (OEM release) version of Windows 95/98.  All OGL display drivers must be OpenGL 1.1 compliant (3DS VIZ R2.x will not work with OpenGL 1.0 drivers).  OpenGL 1.1 is the official version of OpenGL that comes with Windows NT 4.  Both hardware and software OpenGL are supported.


Additional OpenGL Requirements:


1. The device must support the following pixel formats                   


	PFD_DRAW_TO_WINDOW (windowed usage)


	PFD_SUPPORT_OPENGL (support OpenGL)


	PFD_DOUBLEBUFFER (support double buffering)                    


	PFD_SWAP_COPY (copy back buffer to front)


2. The device should, for acceptable performance, support the following OpenGL 


	extensions:


	GL_KTX_buffer_region (dual planes):


	GL_WIN_swap_hint (incremental scene rendering): 


	GL_EXT_bgra (BGRA pixel/texture Format):


3. Any graphics driver must be multi-thread safe. 


4. 3DS VIZ does not support indexed color (8-bit/256 > color) display through 


	OpenGL.


5. 3DS VIZ does not use overlay or stencil planes, although  their presence on the 


	card or through the driver is not detrimental to performance.  They're simply 


	unused at this time.





	Kinetix is re-evaluating display card support based on these requirements and will post 


	results on the Kinetix website (www.ktx.com).





OpenGL Note: Display slowdowns occur when using Loft Deformation modeless dialogs over enlarged viewports in OpenGL. You can speed up the display by turning off Redraw Scene on Window Expose in the OpenGL configuration dialog (File/Preferences/Viewports). However, this may cause artifacts to appear when moving the dialogs. Press "1" to refresh the viewport and clear any artifacts. The display slowdown does not occur in a standard multiviewport configuration.





3DS VIZ R2.x supports HEIDI 5.0. Graphic chip companies (such as 3D Labs) have recently released drivers for HEIDI 5.0.  Check with your display card manufacturer to see if they are working on a HEIDI driver update for your graphics card. 





Mouse Drivers


Make sure you are using the most current drivers for your pointing devices.  Old or obsolete drivers may cause unpredictable results and program failures.  The best method to obtain updated device drivers is to go to the URL for the manufacturer of your device and download the latest driver from the website.





Logitech:


The Microsoft Intellimouse drivers work fine with Intellimice and Logitech type mice.  However, using the Intellimouse system with a generic mouse driver may cause 3DS VIZ to crash.





Machines with CYRIX/AMD processors 


The 3DS VIZ Profiler utility uses Intel Pentium-specific instructions, so it does not load with processors of other types. This will cause a DLL initialization failure in acap.dll when loading 3DS VIZ. This utility is installed only if MAXSDK is chosen as an option in the custom install. For this reason you should remove the files "\3dsviz2\acap.dll" and "\3dsviz2\StdPlugs\MaxProf.dlu" on these systems.





Online Reference


Using HTML Help


The HTML-based online documentation system was developed with Microsoft HTML Help Workshop 1.1.  It is similar in appearance to standard Windows Help that you use with your desktop products. The main differences are:





The 3D Studio VIZ R2 Online Reference use Microsoft's Internet Explorer web browser as the viewing engine instead of the Windows Help viewer, winhelp.exe.


Browsing HTML Help does not connect to the Web; you simply read the help files on your local hard drive. Internet Explorer is only used as a viewer for the help content.


The Online Reference help file is made of compiled HTML files.  This conserves disk space and creates a single .chm file for each help system.


The help systems for 3DS VIZ requires Internet Explorer 4.01.  You must have IE 4.01 installed in order to view the online documentation. When you install 3DS VIZ R2, IE 4.01 is installed on your system as well. (The Internet Explorer setup program installs IE 4.01 even if you already have it installed. This installation program comes directly from Microsoft and we have no control over how it works.)


You can use the Windows Control Panel to uninstall IE 4.01. However, you will no longer be able to read the 3DS VIZ help files, and if you select the Online Reference from the Help Menu, the program may fail.  


Uninstalling 3DS VIZ does not uninstall Internet Explorer.


You can access the Web to see if new information has been posted about 3DS VIZ.  Use your normal web browser to do this. In 3DS VIZ, choose Help>Connect to Support and Information to launch a browser that views the 3DS VIZ R2 site at: 





		http://www.ktx.com/3dsvizr2/html/support.html





Problems with Internet Explorer 4.01


Internet Explorer 4.01 sometimes becomes default browser on install. When installing 3DS VIZ R2 on a computer which uses Netscape as the default browser, occasionally the IE install from Microsoft automatically becomes the default browser.  This is a problem with the IE 4.01 Setup from Microsoft.  Kinetix is not able to modify this behavior.  The next time you launch Netscape, you can change it back to your default browser.   You can find instructions on this at http://home.netscape.com/download/win32_instructions.html.  Basically, you have to go into IE and uncheck the option that makes it the default browser. Then you restart Netscape. If Netscape does not prompt you to become the default browser you have to edit one of its system files (pref.js) so the next time you launch it the appropriate dialog will appear.





How to Use the 3D Studio VIZ R2 Online Reference


To use the Online Reference, choose Help>Online Reference or Help>Additional Help.  3D Studio VIZ opens the help system you select.  You can also open the Online Reference by clicking the "?" button on 3DS VIZ windows, or by pressing the F1 key. The MAXScript help file is located on the main Help menu.   Help for any 3rd-party plug-ins you install, such as Smooth Move Panorama SE, are located under Additional Help. 





Software Developers Kit


The 3D Studio MAX/VIZ SDK for R2 is included as an install option under Custom Install on the 


3D Studio VIZ R2 CD. The SDK now requires Microsoft Visual C++ 5.0





Swap File Size Affects Performance


Performance of 3D Studio VIZ is reduced if the swap file is too small. We recommend a swap file 


size of at least 100MB, with an ideal swap file size of 200MB to 300MB. The general recommendation is that your swap file size should be at least three times the system RAM.





Revisions to Network Rendering


Network rendering generally works by sending out frames to individual machines where they output still images for compositing.  There is no utility (e.g Video Post) included with the program for directly compositing individual frames into a digital video format such as .AVI, .FLC, etc. However you can create digital video files with 3D Studio VIZ by defining the already-rendered files as a background environment map in a new 3D Studio VIZ session and defining .AVI, etc. as the rendered output format. Be sure to read the Network Rendering help section before installing or using 3D Studio VIZ network rendering functions. 





Hardware Locks


·	Hardware locks should be attached in chronological order, with the oldest lock closest to 


	the machine. If you have locks of the same type, you should have the ones with higher 


	serial numbers after the lower ones.  The correct order is the 3DS VIZ 1.x lock is first, 


	and the 2.0 upgrade lock is after.





·	The hardware lock must remain connected at all times. 3D Studio VIZ periodically 	checks 	for the presence of the hardware lock. Depending on what you are doing at the 


	time the check occurs, the program might do one of the following:





	+	Warn that the lock is missing and provide the option to save your work before 


		exiting.


	+	Exit without warning.





	To avoid losing work due to a disconnected hardware lock:





	+	Make sure the lock is securely attached to the system parallel port before 


		starting the computer.


	+	Avoid attaching the lock to switch boxes or other peripherals that might interrupt 


		the connection.


	+	Save your work immediately if you suspect the hardware lock has been 


		disturbed or that the connection has been interrupted. After saving, make sure 


		the hardware lock connection is secure.


	+	Use the Auto Backup feature in the Preference Settings dialog to save your work 


		at regular intervals. 


	+	Save your work and power down the computer if the lock is "partially" connected. 


		Trying to attach or detach a partially secured lock with the computer turned on 


		can damage your parallel port as well as the hardware lock.





·	Hardware lock conflicts with Printers. If a printer is connected through the same port as 


	the hardware lock, one or both of the following conditions might be necessary for the 


	lock to work correctly:


	+	The printer is turned on.


	+	The printer is online.





·	Hardware lock conflicts with external parallel port drives. A number of popular external 


	drive devices can be connected to your computer through the parallel port. Examples of 


	these devices include: Iomega™ ZIP drive, Bernoulli™ drives, CD-ROM drives, and 


	tape drives. 





	You are strongly advised to connect these devices to a parallel port different from the 


	port to which the 3D Studio VIZ hardware lock is connected. If you must connect the 


	hardware lock to the same port as an external drive device, the following information will 


	help you avoid damaging the hardware lock:





	+	Place the hardware lock between the computer and any external drive 


		connected to the same port. An example of such a connection might be:


			[Computer]---[Hardware Lock]---[External Drive]---[Printer]	





	+	Do not place the hardware lock on the external drive's pass-through connector. 


		By doing so you risk burning out the memory in the hardware lock.





	If your hardware lock is damaged, contact your 3D Studio VIZ dealer and turn in the 


	damaged lock for a replacement.





Installing Third Party Plug-ins


Plug-ins from third party developers can destabilize 3D Studio VIZ. If you are testing beta versions of plug-ins, or are unsure whether a plug-in is causing problems running 3D Studio VIZ,  you can place the suspect plug-ins in a separate directory and use a second 3D Studio VIZ program item to launch 3D Studio VIZ with the third party plug-ins enabled. Use the original program item to launch 3D Studio VIZ with only its shipping plug-ins. Use the following technique to create the second program item:





	1.	Install the new plug-ins in a separate directory.


	2.	Copy plugin.ini to a new file name, such as testplug.ini.


3.	Add a line under the [Directories] heading in testplug.ini that points to the separate plug-in directory. For example:


		test plug-ins=C:\3DSVIZ2\TestPlug


	4.	Create a new program item for 3D Studio VIZ.


5.	Change the properties for the program item. Use the -p command line argument to load testplug.ini.  For example:


		C:\3DSVIZ2\3DSVIZ.EXE -p testplug.ini


	6.	Launch 3D Studio VIZ using the new program item.





This segregates new plug-ins from the main 3D Studio VIZ plug-ins. Launch 3D Studio VIZ using the original program item to exclude loading the new plug-ins. If you have problems running 3D Studio VIZ after installing the new plug-ins, launch 3D Studio VIZ using its original program item to determine if the new plug-ins are causing the problem. 





See the 3D Studio MAX Plug-in Compatibility section for compatibility information.





Sentinel for i386 Systems


3D Studio VIZ R2 installs the sentinel driver version 5.30. The Sentinel for i386 Systems (snti386.dll) lock driver version 5.33 causes 3D Studio VIZ 1.x, 3D Studio MAX R1.2 and R2 to run noticeably slower.  For older versions of 3DS VIZ and 3DS MAX, use version 5.30. Note: The sentinel driver version 5.33 is supplied on the 3DS VIZ R2 CD.  This version works fine with 3DS VIZ R2 and will also allow the program to run on Beta versions of Windows NT 5.0.  To find out which version you are running, select the version tab of the properties dialog box for snti386.dll located in your winnt\system32 directory.





	To uninstall version 5.30:


		Note: This should not be done while 3DS VIZ is running.


	1.	Click the multimedia device setting icon in the control panel. 


	2.	Select the Devices tab in the Multimedia Properties dialog, and Other 


		Multimedia Devices from the list.


	3.	Choose Sentinel for i386 Systems.


		Note: If Other Multimedia Devices or Sentinel for i386 Systems don't appear in 


		the list, the Sentinel driver is not installed.


	4.	Click Remove.





	To install version 5.33:


	1.	Go to the \Sentinel\Win_nt50 directory located on the 3D Studio VZ R2 CD and 


		run SetupX86.exe.


	2.	Restart Windows.


	3.	\Sentinel\setup.exe installs the 5.30 drivers.  There is no associated dialog when 


		you click Setup;  it reinstalls the 5.30 drivers without any notice. 





Using Sentinel drivers 5.30 on Dual Parallel Port Systems


There is a known problem with the Sentinel Driver 5.30 and dual parallel port machines that causes poor performance on 3DS VIZ R1.0 or R1.01. 





To fix this on Windows NT:


	1.	Open Control Panel.


	2.	Click Multimedia.


	3.	Select Devices from the tabs.


	4.	Click Other Multimedia Devices.


	5.	Click Sentinel for i386 Systems.


	6.	Click Settings. This brings up a list of the parallel ports.


	7.	Click Edit for the port that is not being used for the 3DS VIZ hardware lock.


	8.	Click "No" for the "Use this port" setting. This should turn off the port for the 


		Sentinel driver only, leaving the port available for any other device attached to 


		it.





To fix this on Windows 95/98:


Option 1:  Use your computer's System Setup, which is accessible prior to booting into Windows 95, to reverse your parallel port addresses.  For instance, most dual parallel port systems access port addresses 278 and 378.  Switching these addresses on machines that exhibit slow menu performance in 3D Studio VIZ release 1.0 or 1.01 should remedy the problem.





Option 2:  Check the Support Section of the Kinetix website at www.ktx.com for the latest technical notes relating to Sentinel Hardware Lock drivers.





Authorizing 3D Studio VIZ R2


After installing 3D Studio VIZ R2, you have 30 days to register your software with Autodesk Customer Service and obtain an authorization code. The product is fully functional during this time period, but will cease to function if unauthorized after 30 days. 





To obtain an authorization code: 


	1.	Ensure 3dsviz.exe is not running.


	2.	Run vizauth.exe by clicking on the "Authorize 3D Studio VIZ R2" icon in the 


		program group you installed for 3DS VIZ (by default this is Kinetix). 


	3.	A dialog will appear containing your product's serial number and requesting an 


		authorization code. 


	4.	Contact the representative designated on the enclosed registration card to obtain 


		the authorization code.


	5.	Record this number in case you need to reinstall 3DS VIZ from the CD-ROM.





Please note that this authorization has no connection to your hardware lock. You can switch locks if necessary without effecting your authorization.





------------------------------------- 3D Studio VIZ Notes ---------------------------------------


Animate:


·	Spinners remain animated in 3D Studio VIZ R2 when 3D Studio MAX 2.0 files are 


	opened even though they have no effect on the object.





Asset Manager:


·	Browsing large directories with the Asset Manager Utility can sometimes lead to a 


	program failure if you browse to a different directory and close the Asset Manager Utility 


	before the images are fully loaded.





·	The Mouse Placement Drag-and-Drop feature in the Asset Manager Utility gives 


	improper results	when importing .DWG files.  Blocks are incorrectly positioned.  To


	position the file accurately in the viewport, import the .DWG file by world space origin, 


	apply GROUP to treat blocked entities as a single object, and then Select and MOVE the 


	grouped objects by dragging the mouse or by the 	Move Transform Type-In


	method.





Booleans:


·	Boolean2 booleans saved in 3DS VIZ R2 do not load in 3DS VIZ R1.x, 3DS MAX R1.x or 3DS MAX R2. In other words, they are not backward compatible. You will see the error message "Missing DLL File Name:DEI.DLO Class Boolean 2". To work around this in 3DS VIZ R2, extract the Boolean operands and delete the Boolean object.  When working in releases prior to 3DS VIZ R2, load the scene and create a Boolean with the two operands.





·	Booleans may sometimes return erroneous results when using complex objects as 


	operands. Refer to "What's New with Booleans" under the Boolean heading in the Online 


	Reference for details and tips.





Camera Match:


·	2D Camera Match point locations assigned over a bitmap are lost if merged into other 3D Studio VIZ scenes. 3D CamPoint locations and names are merged correctly, but 2D alignment points must be re-entered. Previously generated cameras using Camera Match are unaffected and will merge without errors.





DGN File I/O:


·		The DGN I/O requires Microstation version 5.5.8.x or newer.  It will not work with older 


versions.





·		DGN solids are imported into 3DS VIZ without capping.  The objects can be capped in 


3DS VIZ using a cap holes modifier, or they should be converted to surface objects prior 


to import.





·		Rotated splines don't extrude in local z direction after import into 3DS VIZ.  This means 


that a wall containing a window may import with the window capped over.  This is 


because entities are capped in 3DS VIZ with an extrude modifier of 0 length.  Extrusions 


are supposed to follow the local Z direction, but MicroStation doesn't store this 


information for the importer.  This means that all objects imported from MicroStation will 


extrude in the world Z direction instead of the local Z direction.





·	Many MicroStation elements are imported with their pivot point at the origin instead of 


	centered to the object. To correct this, execute the following steps to align the pivot point 


	to the center:





	1.	Select the objects.


	2.	Go to the Hierarchy Panel and click Affect Pivot Only in the Adjust Pivot rollout.


	3.	Click the Center to Object button, then click Affect Pivot Only again to turn it off.





	Now all objects will have their pivot points centered instead of at the origin.





·	Undoing a DGN import resets instead of reimporting the scene. If you cancel a DGN 


	import after choosing to completely replace the scene, choosing Undo will reset 3DS VIZ 


	instead of bringing back the previous scene.





·	Cone objects with World-Space Modifiers used as Object-Space Modifiers (Camera 


	Map, PatchDeform, PathDeform, and SurfDeform) cannot be exported into MicroStation.  


	The cone must be converted to an editable mesh in order to export to MicroStation 


	properly.





·	Archimedian spirals have sharp corners after import. Use clothoid or logarithmic spirals 


	to achieve expected results.





·	3DS VIZ scenes that contain groups will not export properly to MicroStation unless the 


	Ignore option is selected in the Convert Groups To section of the DGN Import Dialog.





·	Text shapes are imported without capping even if Cap Closed Elements is checked.





·	Attached splines don't stay attached following export. Attached splines such as a 


	donut object or two lines attached via Edit Spline are exported into MicroStation as 


	individual elements.





·	Converting instances to shared cells is not supported.





·	On some systems, the MicroStation text window is displayed during the 


	import/export operation.  This has no bearing on a successful import/export and it should 


	go away once the process is complete.





·	NURBS curves are not exported into MicroStation.  If you encounter an error message, 


	click OK and the rest of the scene should be exported properly.





·	Multilines are only imported as closed splines, so they don't contain any of the detail of 


	different multiline styles.





·	Some curves may import into 3DS VIZ with sharp corners. To correct this, set the 


	surface deviation to a lower value (try 0.01).





·	MicroStation slab and wedge objects are imported with missing faces in 3DS VIZ.





·	The AutoCAD ACI Color Palette numbered 1-255 is exported to MicroStation as 0-254.





·	Importing a .DGN file into 3DS VIZ and then exporting back to .DGN results in a much 


	larger file than what was originally imported.





·	The DGN conversion status dialog does not work under Windows 95.  After clicking OK 


	in the DGN Import/Export dialog, an empty error message appears behind the 3DS VIZ 


	window.  Select this window from the taskbar and click OK to close it.  The DGN 


	conversion status dialog stays at 0% until the import/export is complete, but this has 


	no bearing on the success of the import/export.





·	Exported objects with high face counts cannot be manipulated properly in MicroStation. 


	If only a portion of the object can be manipulated in MicroStation, then the object has too 


	many faces. Use the Drop Element command in MicroStation to break the object into


	individual faces. Then use an appropriate method to manipulate the object as a whole 


	(cells, groups, fencing, etc.).





Door Objects:


·	When THICK 2 < THICK 1 on beveled panels, the bevel is interpreted incorrectly. A 


	45-degree bevel bends "inward" where it should just re-convert itself so that the beveled face is still facing forward rather than inward.  If an inward facing bevel is required, key in a negative number or one that is >90 degrees.





·	Door mapping is inconsistent with window mapping. If invalid mapping occurs, modify the UVW mapping coordinate for the particular subobject in question from a planar map to a box map type.





·	Bottom created doors (doors started from the bottom of the wall) do not automatically 


	boolean in procedural walls that were created by keyboard entry or the Pick Spline 


	button. Linking them to the wall will cause them to boolean properly.





DXF File Import/Export:


·	The weld toggle does not work in DXF Import. To correct this, select the geometry you want to weld after the import and do the following:





	1.	Add an Edit mesh


	2.	Click Sub-object Vertex


	3.	Select all the vertices


	4.	Click Weld.





·	Smoothing groups are applied to DXF files imported from AutoCAD regardless of the Auto-Smooth box state.  Solution: During Import,  turn on Auto-Smooth and set the angle to zero. If you have already imported the file and you want to remove the smoothing, follow these steps:





1.	Select the polylines to unsmooth. 


2.	Click the Modify tab.


3.	Click the Sub-Object button, and switch to Face mode.


4.	Select all the faces of the selected polylines (which are now "Editable Meshes").


5.			Scroll down to the "Edit Surface" rollout. Under all smoothing group buttons.


	6.	Click Clear All.





DWG Linking:


·	This release of 3D Studio VIZ (R2.01) now supports the AutoCAD 2000 file format. It 


however, does not support new ACAD2000-specific entities.





·		This patch is also compatible with Architectural Desktop Release 1.0 and Land 


		Development Desktop Release 1.0.





·	Objects created with AutoCAD R12 AME will appear in 3DS VIZ as wireframes.





·	The One-to-One filter does not update transforms of blocks in AutoCAD.





·	Linked objects cannot be grouped with 3DS VIZ objects. To correct this, delete the linked


	UCS helper icon. 





·	Deleting all of the objects in the link permanently removes the nodes from the link. 


	Reloading the link does not restore the nodes.





·	2D shapes created in non-WCS can have erroneous (or WCS) extrusion directions 


	when you apply an Extrude Modifier to the VIZBlock. Apply the Extrude Modifier to the 


	individual LinkedDrawingObjects in the Modifier stack to correct this problem.





·	The One-to-One filter does not respect AutoCAD's Rotate3D command.





·	Linked terrain objects are displaced when viewed with Edged Faces on Open GL video 


	configurations.





·	Boolean of linked ACIS solids is not supported.





·	AutoCAD blocks may have inconsistent pivot points at the sub-object level.





·	Attaching one VIZBlock to another VIZBlock can cause members to be displaced.





·	Reload over a network may not work. If the red flag doesn't appear on files that are 


	linked over the network, disable "Create backup copy with each save" in the 


	File>Preferences>General or set ISAVEBAK to 0 in AutoCAD.





·	When linking, a drawing which contains multiple objects of different colors does not 


	update the color changes when reloading.  Relink the drawing to update the colors.





·	Cursor flickering can occur in snap mode when snapping to linked objects.





·	When applying an Extrude Modifier to multiple members of a VIZBlock at the subobject 


	level (LinkedDrawingObject), the modifier may disappear when you reload. This usually 


	occurs when the Combine by Filters Color/Thickness or Layer/Thickness are used with 


	the Preserve Access to Individual AutoCAD Entities option. Use the following to correct 


	this situation:





	1.	Extract the objects from the VIZBlock and apply the modifiers. Note: Using this 


		method further updates may be lost.





	2.	Attach the drawing twice. The first time excluding the layers containing the 


		entities you want to handle separately; the second time exclude all but the layers 


		you previously excluded and use a filter option that gives you more separation 


		between the individual entities.Once they are separate objects and not operands 


		within a single VIZBlock, modifiers can be applied normally.





Installation:


·	The progress meter is not accurate when using the CUSTOM installation type.





Lights:


·	Free Direct Lights keep the Sunlight System naming conventions if the Sunlight object is 


	added to the scene after you've created Free Direct Lights. If you rename a Sunlight 


	system (e.g. SUN01) and then set up another Free Direct Light in your scene, the default 


	naming will continue with the series established by the Sunlight system (e.g. SUN02). To 


	correct this, reset the name to what you want (e.g. FreeLight 02, etc.).





Materials Installation:


·	3D Studio VIZ R2 allows you to install either the typical material library consisting of 


about 125 materials or the complete material library of over 500 materials. The typical 


install option requires ~35MB whereas a complete installation requires over 400MB. The option you choose may depend on your computer's available hard drive space. If you choose to install the typical library and wish to add the additional materials later, you can manually install certain categories of materials by browsing the 3D Studio VIZ R2 installation CD. Material categories are located in the "Samples\Maps" directory of the CD. To install individual material libraries, follow these steps:





1.	Copy the bitmaps belonging to a certain category (i.e. "paints") into the \3DSVIZ2\MAPS directory of your 3DS VIZ installation.


2.	In the Material Editor, select "Merge" in the Material Map Browser. 


3.	Browse the installation CD in the category from which you copied the maps.


4.	Select the material library (i.e. "paints.mat") in that directory and then click OK. The material library is merged into your existing material library.


5.	Save the default "3DSVIZ.MAT" library to complete the process.





Material Library/Editor:


·	Multi/sub-object material numbering may not begin at the correct default values when 


3DS VIZ R2 is initially run. Close the Material Editor, click File/Reset, then re-open the Material Editor and select Type:Multi/subobject.





MAXScript Help:


·	The MAXScript help entry for NURBS1RAILSWEEPSURFACE is incomplete. Check 


	the Kinetix web server (www.ktx.com) for an updated MAXScript help file.





·	The MAXScript Help reference for EnableEscape is incorrect. It should be 


	EscapeEnable.





Outlining Splines:


·	Problem: In some situations, an Edit Spline Outline may apply an incorrect segment line type to a portion of the outline (e.g. a curved segment may be drawn straight). This occurs with individual splines that contain a mixture of Line and Curve segment types. Solution: Change to Segment sub-object mode, select each segment that is incorrect, and change its segment type. For example, change Line to Curve, or Curve to Line.





AutoCAD 2000 DWG Import/Export Plug-in:


Below is a list of currently known issues in the DWG File Import/Export plug-in.





·	When using the "Group Common Objects" toggle or the "Completely replace current scene" option, object numbering may not start at 01, and may not be incremented by one. However, the names of all imported objects will be unique.





·	When using the Convert to Single Objects option, objects with different thickness and different extrusion directions will be converted to separate objects. Separate Extrude modifiers are applied to each unique combination.





·	Importing AutoCAD files using the "Completely replace current scene" option can be extremely slow. Use the "Merge objects with current scene" option instead.





·	Exporting Extruded circles do not cap regardless of the "Ignore Extrude Capping" toggle.





·	The default near clip distance applied to imported cameras may be too large. Clip manually, and adjust the clipping distances instead.





·	Custom entities (MCAD™ entities) do not import. Models created using AutoSurf™ or AutoCAD Designer™ do not import using the AutoCAD DWG Import/Export plug-in. 





·	MLINE entities that have been edited with the MLEDIT command in AutoCAD do not import properly.  Explode edited MLINE entities in the .DWG file before importing.





·	Lights are not exported into AutoCAD. Exporting any scene containing lights will display a dialog stating "Template.DWG is not in the same directory as DWGEXP.DLE, lights will not be converted." However, all other entities (besides lights) are converted.





·	DWG files containing large quantities of AutoCAD solids (~50,000) can take a long time 


	to import.





·	Auto-Smooth OFF during import does not work. To correct this, leave AutoSmooth ON


	and set the angle to zero.





·	Using higher values (>0.1) with Surface Deviation may not return desired results.





·	Hue and Saturation values after linking may not match AutoCAD R14 values. This is due 


	to a difference in the way AutoCAD and 3D Studio VIZ R2 calculate Hue and Saturation 


	values from the given RGB values.





·	Exporting of selected NURBS is not supported.





·	DWG Import does not support hatches created in AutoCAD R14.





·		The weld option may cause some drawings to take a very long time to import, especially 


		drawings containing many polylines.  To workaround this, simply turn off the weld option 


		when importing.





·		The Save As option now allows you to save as an R14 DWG file; you can no longer 


		export directly to an R13 format DWG file.





RadioRay:


·	RadioRay 1.01 installs a version of the SUNLIGHT.DLO plugin file that is incompatible with  3D Studio VIZ R2. If you install RadioRay 1.01 after installing 3D Studio VIZ R2, you will encounter the following error message upon program launch: 





	 "DLL <C:\3dsviz2\Stdplugs\sunlight.dlo> is an  obsolete version - not loading."





	To correct this, delete the SUNLIGHT.DLO that the RadioRay setup puts in your \3DSVIZ2\STDPLUGS directory and then rename SUNLIGHT.BAK to SUNLIGHT.DLO. 





Railings:


·	Undoing the action of Pick Railing Path will undo the path assignment, but won't return 


	the railing to its previous position.





·	Railing objects may have a twist when assigned to paths that contain 


	vertical segments (such as the inside rail path of a U-type stair).





·	Railing objects are not recognized by MAXScripter.





·	Railing objects do not conform to variations in spline interpolation.





·	Railing objects assigned to NURBS curves will not update immediately after deleting a 


	point or CV in the curve.  Selecting and moving the point or CV will update the railing 


	properly.





·	Railing objects assigned to NURBS curves will not update immediately after undoing the 


	movement of a point or CV.  Selecting and moving the point or CV will update the railing 


	properly.





·	Setting the Post Count to an extremely high value (>100000) can cause program failure.





Raytrace Materials:


·	Global Parameters/Options do not reset to default values when a raytrace material is 


	present in a library. The options/global parameters are being picked up from the raytrace 


	material in the active library instead of being reset to default.





·	The Dynamics properties rollout is enabled for raytrace materials but is not supported.





Render:


·	Object Motion Blur is not supported in 3D Studio VIZ R2.





Sectioning Tool:


·	Extruding sections exhibits different behavior than other entities.  The weld operation attempts to close section splines, but this is not always possible.  Because of this, when a section that results in open splines is extruded, the resulting mesh has arbitrary normals and is not capped.  This is particularly true for sections coplanar with meshes or patches.





·	The weld operation can be slow on sections that are coplanar with quad patches.





·	Section information can only be exported using the DWG format.  Using DXF, 3DS or any other format will either not work or produce undesirable results.





SmoothMoveTM Pan Viewer:


·	Although 3DS VIZ R2 comes with the SmoothMove Pan Viewer 5.0 release 2, it is not an 


	installation option. Run the SETUP.EXE program in the \PANVIEWER directory on the 


	3DS VIZ R2 CD to install the viewer.





Snaps:


·	The perpendicular Osnap extends the first and last segment of a line to find a perpendicular point.  This can result in Osnaps that are not on the line.





Spacing Tool:


·	After using the Spacing Tool, automatic new object naming in the Create panel appears 


	to be stuck on the name of the arrayed object when you create new primitives. They are 


	named properly when you switch to the Modify panel. This condition is corrected when


	the program is restarted.





Stairs:


·	Undoing of U-Type stair parameters doesn't undo dependent parameters. For example, 


	increasing the offset automatically decreases the stair width although undoing this 


	increased offset 	will leave the width at the decreased value.





·	Decreasing the radius of a spiral stair will also decrease the width. This means that the 


	width is always less than or equal to the radius. However, increasing the radius has no 


	effect on the width.





·	The rail paths created with stairs are separate objects. They are neither cloned when a 


	stair is cloned, nor deleted when a stair is deleted.





·	Adjusting the width of a centered carriage will cause the carriage to no longer be 


	centered.  In order to center the carriage again, open the Carriage Spacing dialog.





Sub-Object Animation:


·	3D Studio MAX files retain their sub-object animation properties when opened in 3D Studio VIZ. When files containing sub-object animation properties are opened in 3D Studio VIZ, the sub-object pivot may still be animated. Although sub-object animation is not supported in 3D Studio VIZ, it is maintained in files created in 3D Studio MAX. All sub-object animation is interpreted at frame 0.





Sunlight System:


·	System time zone settings outside of a GMT - 8:00 cause erroneous results. The Sunlight System time zone is not being preset to the location it's installed to. To correct this, reselect your location from within the Geographic Location dialog before your initial rendering.





·	The Creation Cursor disappears in the viewport with the following ELSA Gloria video board configuration:





Manufacturer:  ELSA GmbH Aachen (Germany) 


Version Numbers:  5.04.00.037, 4.0.50


Current Files:  WINNER.sys, WINNER.dll, WINNERMB.dll


Chip Type:  S3968 + GLint 300SX/Rev. 2


DAC Type:  TI 3030





Check the ELSA web site for updated drivers (www.elsa.com) as they become available.





Terrain:


·	Situations in which a contour line curves back towards itself in a distance which is 


	smaller than or similar to the horizontal distance between successive contours may give 


	under-interpolated results. In this situation, the current algorithm tends to "straighten out" 


	the contour line. The result is a somewhat smoother surface than would be inferred by a 


	person looking at the contours. This is particularly evident in Layered Solid Terrain 


	forms. If this occurs (and to significantly improve the results of the Terrain form), create 


	3D spline or 3D polyline data in gully areas and add it to the Terrain object.





·	Terrain uses splines vertices to generate the triangulation of the mesh object. The 


	Normalize Spline Modifier, freeware from Peter Watje, creates additional vertices in a 


	spline, separated by a User Defined distance. This makes the spline more faceted, and 


	the Terrain to compute a more densely triangulated solution. Note: The Normalize 


	Spline modifier is freeware and is not supported by Kinetix Product Support.





Volume Fog & Wind Effects:


·	The volume fog atmospheric effect has a number of settings for wind effects. These do not animate in 3D Studio VIZ.





Walls:


·	With center justification turned on, the last corner can be misplaced outside the wall 


	during insertion. To correct, turn off the center justification.





·	Segment/Detach Same Shape will always create a copy regardless of the Copy option's 


	setting.





·	Inserted corners may fail when changed from right justified to centered. To correct, 


	select Left justified, then Centered. 





·	Attempting to weld walls when the "ends" or "starts" of two wall sections come together is 


	not supported. Rotate the wall so that the "end" of one wall is abutted to the "start" of the 


	second wall.





Windows 95® Compatibility:


·	If you receive a Transport Error when launching 3D Studio VIZ R2 on Windows 95®, use the command line argument -n to disable network checks. Enter 3DSVIZ.EXE -n (lowercase "n") in the command line to launch the program. 





Window Objects:


·	Creating very small window objects can cause the window to disappear at certain points in the viewport. The window code checks for small overall sizes, and purposefully does not display itself when these values are too small. The window can still be selected using the object list, and can either be deleted or modified from there. 





·	Parametric windows created with the Generate Mapping Coordinates option checked may result in invalid mapping coordinates to subobject faces. This is particularly visible in the rail divisions of windows with textured materials applied. If invalid mapping occurs modify the UVW mapping coordinate for the particular subobject in question from a planar map to a box map type.





·	Hinged Window objects open from the centerline of the sash.  If you want the sash to 


	pivot from an edge, then you must detach the entities which make up the sash, apply a 


	Xform modifier to the new Sash object and move the Xform center to the desired 


	location. If you use Edit Mesh to detach the Sash, then you can Copy/Paste/Instance in 


	Track View between the Window %Opening controller and the Sash Xform Euler 


	Rotation axis. Since the Euler axis rotation units are in radians, the rotation will be much 


	more sensitive to changes in the %Opening value.





3D Studio VIZ R2 Tutorial Guide:


·	Following the steps in the Tutorial Guide, Chapter 2 "Constructing A Fireplace" on page 


	40 creates a display problem which may be confusing. When the tutorial instructs you 


	click the 3D Snap Toggle to turn it on, then right click the same button to display the 


	Snap panel on the Grid And Snap Settings dialog, the red outline of the fireplace in the 


	User viewport changes to a rectangle.  To correct this, press "1" to redraw the viewports.





3D Studio VIZ User's Guide


·	Under Material Type: Multi/Sub-Object, callouts identifying Subtraction types have been 


	reversed.  Subtraction: A-B should read Subtraction: B-A.  Conversely Subtraction: B-A 


	should read Subtraction A-B.





3D Studio MAX R2.X Plug-In Compatibility:


The following is a list of 3D Studio MAX plug-ins and their current status regarding compatibility with 3D Studio VIZ R2.





Compatible Plug-ins/Notes:


+	Character Studio	Biped is compatible, Physique is not due to the 


				non-existence of IK support.


+	Pandora		Functions at object level.  Does not function at sub-object 


				animation level.


+	Shag:FUR		Functions at object level.  Does not function at sub-object 


				animation level.


+	Splash!MAX		Functions at object level.  Does not function at sub-object 


				animation level. 


+	ViZfx


+	SurfaceSuite


+	RadioRay 1.01		See the RadioRay section for specific information regarding 


				installation instructions.


+	Clay Studio Pro





Incompatible:


-	HyperMatter


-	ScatterMain


-	Bombs2


-	Fractal Flow





3DS VIZ Plug-In Compatibility:


The following is a list of 3DS VIZ plug-ins and their respective behaviors in 3DS MAX R2.5:





Stairs and Railings:


·	Users are prohibited in 3DS MAX R2.5 from creating stairs and railings even if they copy 


	the plug-ins to the \3dsmax2\stdplugs directory. 





Walls:


·	The Walls plug-in won't work in 3DS MAX even if the files are copied to the 


	\3dsmax2\stdplugs directory.





DWGLink:


·	This feature is not visible in the Utility Panel even if the files are copied to the 


	\3dsmax2\stdplugs directory. However, VIZBlocks will import correctly if the dwglink.dlu 


	is present in \3dsmax2\stdplugs.





					---- END -----





